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WARNING 
 
 
To ensure the equipment described by this User Manual, as well as the equipment connected to 
and used with it, operates satisfactorily and safely, all applicable local and national codes that 
apply to installing and operating the equipment must be followed. This includes the National 
Electric Code in the USA and other applicable legislation, regulations, and codes in practice 
elsewhere. Since codes can vary geographically and can change with time, it is the user’s 
responsibility to determine which standards and codes apply, and to comply with them. 
 
FAILURE TO COMPLY WITH APPLICABLE CODES AND STANDARDS CAN RESULT IN 
DAMAGE TO EQUIPMENT AND/OR SERIOUS INJURY TO PERSONNEL. 
 
Persons supervising and performing installation or maintenance must be suitably qualified and 
competent in these duties, and should carefully study this User Manual and any other manuals 
referred to by it prior to installation and/or operation of the equipment. 
 
 
The contents of the User Manual are believed to be correct at the time of printing; however, no 
responsibility is assumed for inaccuracies. In the interests of a commitment to a policy of 
continuous development and improvement, the manufacturer reserves the right to change the 
specification of the product or it’s performance or the contents of the User Manual without notice. 
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SECTION 1 
GENERAL DESCRIPTION 

This section describes the features of the HSM-DUCTOR package.  
This includes the functional description, the user and operator 
selectable parameters, the inputs required and outputs provided, etc. 
 
 
________________________________________________________ 
1.1 FEATURES 
 

Replaces mechanically cammed ductors on can decorator with 
pneumatically controlled ductors.  Controls cyclic ductor 
solenoids on decorator to a resolution of one tenth of a can at 
speeds up to 2400CPM. 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

 
Enables the operator to perform quick label changes by recalling 
the ductor “Cycle” and “On” duration used the last time the 
particular label was run. 

 
Controls cyclic ductor solenoids directly. 

 
Incorporates optional ductor feedback sensor inputs to speed 
compensate for the response time of the solenoid and verify that 
the ductors are cycling. 

 
Keypad adjustment of label parameters (Label Number, Cycle 
Duration and On Duration). 

 
Stores label parameters for up to 100 labels.   

 
User selectable ductor configuration parameters including, 
maximum “Cycle” duration, maximum "On" duration, response 
time compensation and individual ductor feedback enable. 

 
Ductor cycle count data collection, allows the viewing of the total 
number of cycles each ductor has made.  This is used for life 
expectancy and predictive maintenance purposes to determine 
when air cylinders or solenoids should be replaced. 

 
Passcode security access for adjusting label parameters. 

 
Manual/Off/Auto modes of operation. 

 
Provides control for up to 8 ink station machines. 
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SECTION 1 
GENERAL DESCRIPTION  

Provided with DOS or Windows based “Set-up” program. This 
allows all set-up data and label data to be uploaded from the 
M4503 and saved to disk (for back-up). 

• 

• 

• 

• 

 
Built-in 2 Line X 40 character sealed display with 24 key keypad 
allows setting of all user parameters and local viewing of 
collected data (ductor cycle counts). 

 
Interfaces directly with machine mounted resolver. 

 
Based on high performance M4503 PLC/PLS module, that allows 
easy trouble-shooting and user customization using SYSdev 
(DOS-based) programming package. 

 
 
________________________________________________________ 
1.2 FUNCTIONAL DESCRIPTION 
 
The pneumatic ductor color control replaces mechanically cammed 
ductors with pneumatically controlled ductors.   The ductors are now 
activated by air cylinders controlled by solenoids driven by the 
M4503.  This allows the cycle duration (number of cans between one 
complete ductor cycle) and the duty cycle (the time the ductor is in 
contact with the fountain roll or “On” duration) to be adjusted 
independently for each ink station.  This allows the ink flow rate of 
each station to be adjusted based on the amount of ink required for 
each particular color on the label. 
 
The maximum “Cycle” duration, maximum “On” duration, “Response 
Time” compensation and “Color Gain” are set using either the set-up 
program or Keypad/Display.  These values are used with all labels.  
The operator can perform quick label changes by recalling the settings 
used the last time a particular label was run.  Thus when a label 
change is made, the corresponding label number is selected and 
settings for each ink station, used for that label previously, are used 
again. 
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SECTION 1 
GENERAL DESCRIPTION 

When the machine first starts up, the ductors are staged “ON” in one 
can increments.  At the beginning of each cycle, the ductor solenoid is 
activated and the ductor roll comes in contact with the fountain roll.  
Once the “On” duration is complete, the solenoid is deactivated and 
the ink is transferred to the first steel roll.  At the completion of the 
cycle, there is a 5 can dwell period before the next cycle starts.  
During this dwell period ductor cycling operation is checked and 
adjustments made to the “On” duration for the response time of the 
solenoids. 
 
 
________________________________________________________ 
1.3 DUCTOR FEEDBACK 
 
Sensors mounted on the machine sense the actuation of the ductor 
arm, verifies that the ductor is cycling and compensates for the 
response time of the solenoid.  As the speed of the machine changes 
the feedback sensor is used to adjust the amount of time the ductor is 
in contact with the fountain roll.  This allows consistent ink transfer 
throughout the entire speed range of the machine. 
 
If a ductor is not detected as cycling, an output is activated to indicate 
a fault in the ductors cycling operation. 
 
Note:  The feedback sensor must go “ON” when the ductor is in 
contact with the fountain roll. 
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SECTION 1 
GENERAL DESCRIPTION  

________________________________________________________ 
1.4 OPERATOR ADJUSTABLE PARAMETERS 
 
The following parameters can be adjusted by the decorator operator 
through the “Color Control” key on the Keypad/Display: 
 

Label Number (0-99) • 
• 
• 

Ink Station “On” Duration  
Ink Station “Cycle” Duration 

 
Note:  The above values are passcode protected to prevent 
unauthorized personnel from making adjustments.  Also, the “On” 
duration and “Cycle” duration cannot be set within 14 cans (140 
counts) of one another. 
 
Passcode protection can be enabled or disabled via the passcode itself.  
If the passcode is set to zero or the “Set-Up Enable” input is ON then 
passcode protection is disabled, otherwise passcode protection is 
enabled.  If passcode protection is enabled, the operator must enter 
the proper passcode in order to make adjustments to the color control 
parameters.  If the “Set Passcode” input is ON then a new passcode 
can be entered.  If a passcode is not entered, the value is reset to zero. 
 
 
________________________________________________________ 
1.5 USER SELECTABLE DUCTOR CONFIGURATION 
 
The following parameters are used to define the HSM-DUCTOR                               
configuration:  
 
 1) Maximum “Cycle” Duration 
 2) Maximum “On” Duration 
 3) Response Time Compensation 
 4) Color Gain 
 5) Feedback Enable (stations 1-8) 
 
The above parameters are set either using the set-up program or the 
Keypad/Display.  See section 3 for the definitions of these parameters 
and the procedure for setting these parameters using the 
Keypad/Display. 
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GENERAL DESCRIPTION 

________________________________________________________ 
1.6 INPUTS 
 
The HSM-DUCTOR interfaces with the existing PLC using discrete 
I/O, as well as, the existing PLS.  These are as follows: 
 
Ductors Auto "ON" (B100.2): This signal is used to enable and 
disable the ductors when the MANUAL/OFF/AUTO switch is in the 
"AUTO" mode.  This is derived from the existing host PLC and 
should be programmed to enable the ductors when the canfeed is 
open, etc. 
 
Set Passcode (B100.3): This signal is used to reset the existing 
passcode value.  This signal should be derived from a keyed selector 
switch located within the host PLC control cabinet.  Once “Set 
Passcode” has been enabled a new passcode can be entered when 
entering the “Color Control” configuration menu.  The passcode 
cannot be set if “Set-Up” has been enabled. 
 
Alarm Reset (B100.4): This input is used to clear the ductor 
feedback fault based on an alarm reset derived from the existing host 
PLC.  The keypad display has an alarm reset, as well, to clear a ductor 
feedback fault. 
 
Set-Up Enable (B100.5): This signal is used to enable the setup of 
the ductor configuration parameters.  This signal should be derived 
from a selector switch located within the host PLC control cabinet.  
Once “Set-Up” has been enabled the HSM-DUCTOR is in a 
configuration mode and passcode protection is disabled. 
 
Ductor Feedback Sensors (B101.0 - B101.7): These inputs are 
used to verify the ductors for proper operation (see section 1.3 – 
Ductor Feedback). 
 
Machine Mounted Resolver: The M4503 module incorporates a 
built-in PLS which interfaces directly with the machine mounted 
resolver and provides all timing relating to the ductor control system, 
eliminating the need for an external PLS. 
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GENERAL DESCRIPTION  

________________________________________________________ 
1.7 OUTPUTS 
 
The HSM-DUCTOR provides the following DC outputs: 
 
Ductor Solenoids (B110.0 - B110.7):  These outputs drive the 
pneumatic ductor solenoids directly.  The solenoids are cycled at the 
rate specified by the operator settings. 
 
Ductor Fault (B111.0 – B111.7):  These outputs are activated 
whenever the corresponding ductor is detected as failed (via the 
ductor feedback inputs).  These outputs are also interlocked with the 
fault [FLT] relay (this relay is energized when all faults are normal).  
The “Ductors Run Enable” contact should be interlocked with the 
existing control system to stop the decorator if a fault is detected.  
These faults can be enabled or disabled on an individual basis via 
“Set-Up” on the keypad display. 
 
 
________________________________________________________ 
1.8 MANUAL / OFF / AUTO CONTROL 
 
The HSM-DUCTOR contains a MANUAL/OFF/AUTO selector 
switch. This is used to determine the mode of operation.  These are as 
follows: 
 
Manual: Ductors cycle normally while the decorator is running 
(Ductor Auto "On" input from host PLC ignored).  Ductors turn "off" 
(rest on first steel roll) when the decorator reaches zero speed.  While 
the decorator is stopped, each individual ductor can be toggled "on" 
and "off" by pressing the keypad number corresponding to it's station.  
This provides a test method to verify the operation of each ductor. 
 
Off: Ductors always "off" (resting against first steel roll). 
 
Auto: Ductors cycle normally while decorator is running and the 
Ductor Auto "On" input from the host PLC is "on".  Ductors turn 
"off" when decorator reaches zero speed or when Ductor Auto "On" 
input from host PLC is "off". 
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SECTION 2 
INSTALLATION 

The standard control package is provided in a self contained NEMA 
12 enclosure for mounting in the vicinity of the ink stations.  In 
addition, the HSM-DUCTOR can be purchased for mounting in the 
existing user's control cabinet door by specifying HSM-DUCTOR-
UB. 
 
 
________________________________________________________ 
2.1 WHAT’S INCLUDED 
 
Depending on which package is purchased, verify that the following 
items are included when unpacking the HSM-DUCTOR: 
 
HSM-DUCTOR (With NEMA 12 ENCLOSURE): 
 
 1ea. HSM-DUCTOR NEMA 12 enclosure including the 

M4503 PLC/PLS Module 
 
 1ea. HSM-DUCTOR User's Manual 
 1ea. HSM-DUCTOR Keypad Quick Reference 
 1ea. M4500 User’s Manual 
 1ea. HSM-DUCTOR Program Disk 
 
HSM-DUCTOR-UB (For Mounting In Existing Enclosure): 
 
 1ea. M4503 PLC Module 
 1ea. HSM-DUCTOR User's Manual 
 1ea. HSM-DUCTOR Keypad Quick Reference 
 1ea. M4500 User’s Manual 
 1ea. HSM-DUCTOR Program Disk 
 
Note:  The HSM-DUCTOR package comprises only the controls 
portion (PLC/PLS module, enclosure, program, etc.) of the pneumatic 
ductor system.  The mechanical portion of the pneumatic system (air 
cylinders, solenoids, actuation arms, etc.), are not supplied. 
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SECTION 2 
INSTALLATION 

________________________________________________________ 
2.2 POWER REQUIRED 
 
The HSM-DUCTOR is powered from 115VAC 50/60HZ and 
+24VDC.  The 115VAC is used to power the M4503 module while 
the +24VDC is used to power the ductor solenoids and ductor 
feedback sensors (if used).  The +24VDC current required is 2 Amps 
for six stations and 2.75 Amps for eight stations. 
 
 
________________________________________________________ 
2.3 MOUNTING THE HSM-DUCTOR 
 
If installing the HSM-DUCTOR package mounted in the NEMA 12 
enclosure, mount the enclosure in proximity to the ink stations of the 
decorator.   It should be mounted to provide the maximum 
convenience to the operator when performing a label change.    
 
If installing the HSM-DUCTOR-UB package, mount the M4503 in 
the existing control cabinet door. 
 
1) Remove all terminal connectors so that the module can easily 

slide into the recommended cutout. 
 
2) Refer to drawing 14-4515-15, sheet 1, create a cut-out in the 

existing control cabinet door. 
 
3) With the gasket installed on the M4503 mounting studs, slide the 

module into the cut-out from the front.  Attach the M4503 to the 
door with the supplied hardware.  Once the module is installed, a 
lugged earth ground wire should be installed on one of the 
mounting screws to insure that the module is grounded. 

 
4) Re-Install all terminal connectors on the module to begin 

terminating wires. 
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INSTALLATION 

________________________________________________________ 
2.4 WIRING THE HSM-DUCTOR 
 
Refer to the electrical control schematic at the back of this manual, 
wire the HSM-DUCTOR to the existing control system. 
 
Note:  Keep all +24VDC wiring away from high voltage wiring. 
 
1) Wire the resolver input per sheet 1 of the electrical control 

schematic. 
 
2) Wire input terminals 628 (Ductors Auto ON), 629 (Set Passcode), 

630 (Alarm Reset), and 631 (Set-Up Enable), from outputs of the 
host PLC. 

 
3) Wire output terminals 610 thru 617 from the M4503 to the 

respective ductor solenoids as shown on the schematic at the back 
of this manual. 

 
4) Wire FLT1 and FLT2 (Ductors Feedback Fault / M4503 Fault) 

interlock to an input on the host PLC. 
 
5) If the ductor feedback sensors are to be used, wire these sensors to 

input terminals 634 thru 641.   
 

Note:  The sensors should be PNP (sourcing) type sensors. 
 
Wire output terminals 618 thru 625 from the M4503 to the host 
PLC (if desired) for individual “Ductor Feedback Fault” detection 

 
 
________________________________________________________ 
2.5 HSM-DUCTOR SOFTWARE INSTALLATION 
 
The following sections are use to install the set-up software and 
application program files on an IBM PC or compatible, used to 
support the M4503. 
 
The set-up software is used to download the application program to 
the M4503 module, tune the user adjustable (set-up) variables, 
download and upload (save) user set-up variables to disk, and view 
shift data on a PC used to support the M4503. 
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SECTION 2 
INSTALLATION 

________________________________________________________ 
2.5.1 WINDOWS™ BASED SET-UP PROGRAM 
INSTALLATION 
 
The HSMDUCTOR setup program is compatible with Windows 
95/98/ME/2000/XP operating systems and is used to: 
 1) Setup (tune) the user adjustable variables. 
 2) Adjust the color control ON duration and CYCLE duration for 

each ductor. 
3) Download the application program to the M4503 module. 
4) Download (restore) or upload (save) the user setup variables 

from the M4503. 
5) View “Shift” data.  

 
To install the set-up software, perform the following steps: 
 
1) Insert the HSM DUCTOR CD into the drive 
 
2) From the Windows desktop, “Click” Start and then select run. 
 
3) From the “Run” dialog box, “Click” the Browse button.   
 
4) Select the drive with HSM-DUCTOR CD.  Select the “setup.exe” 

file and “Click” Open and then Ok. 
 
5) This will initiate the installation process.  Follow the instructions 
that appear on the screen to complete the installation process.  The 
HSMDUCTOR setup program can be executed from the “Systems” 
folder located in Programs.
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INSTALLATION 

________________________________________________________ 
2.5.2 DOS BASED SET-UP PROGRAM INSTALLATION 
 
Follow the steps below to install the DOS based set-up software on a 
PC used to support the M4503. 
 
1) Create one directory off the root directory for each decorator 

ductor system called "PRINTER1" for the line 1 decorator, 
"PRINTER2" for the line 2 decorator, "PRINTER3" for the line 3 
decorator, etc.  These will be used to store the setup programs and 
set-up data for each decorator.  Create these directories by typing 
the following at the DOS prompt: 

 
MD  \PRINTER1<ENTER> 
MD  \PRINTER2<ENTER> 
MD  \PRINTER3<ENTER> 

 
2) Install disk1 into the “A” drive.  For each "PRINTER" directory 

you created in the previous step, switch to that directory and 
install the set-up programs by typing the following commands at 
the DOS prompt (Line 1 decorator is shown): 

 
CD  \PRINTER1<ENTER> 
A:INSTALL<ENTER> 

 
3) If using a menu program, add each decorator's ductor set-up 

program to your computer's menu software.  The DOS commands 
executed for these selections should be (line 1 printer shown): 

 
For Line 1 Decorator: 

CD  \PRINTER1 
HSMDCTR 
CD  \ 

 
4) To execute the respective decorator's ductor set-up program, 

simply select the corresponding selection from the menu 
software's menu. 
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INSTALLATION 

________________________________________________________ 
2.5.3 SYSdev PROGRAM DEVELOPMENT SOFTWARE 
INSTALLATION 
 
The SYSdev Program Development software is used to perform on-
line trouble-shooting and program modifications to the M4503.  If 
SYSdev was purchased with the control system and is not already 
installed on the computer, install SYSdev onto the hard drive of your 
computer following the steps outlined in the SYSdev Program 
Development Manual. 
 
 
________________________________________________________ 
2.5.3 APPLICATION PROGRAM INSTALLATION 
 
The application program is a SYSdev based program, loaded into the 
M4503 module and performs the HSM-DUCTOR logic. The program 
is written in a combination of Ladder logic and High-level. If the user 
desires to make program changes or perform on-line monitoring of 
the program execution the files, which constitute the HSMDCTR 
program, will have to be loaded onto the hard drive of the PC used to 
support the system. The SYSdev Program Development Software will 
also have to be loaded on the PC. To install this program perform the 
following: 
 
1) Install the “PROGRAMS” disk into the drive.  
 
2) For each of the "PRINTER" directories (created in section 2.8.2), 

copy all the files from the disk to each of these subdirectories. 
 
 
________________________________________________________ 
2.6 DEFAULT DUCTOR CONFIGURATION SETTINGS 
 
As shipped, the ductor configuration settings are as follows: 
 
 Maximum Cycle Duration (0.1 cans)  : 500 
 Maximum ON Duration (0.1 cans)  : 200 
 Response Time Compensation (msec)  : 25 
 Color Gain (CG-100% per 2000CPM)  : 100% 
 Feedback Enable (Stations 1 – 8)  : N 
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INSTALLATION 

________________________________________________________ 
2.7 HSM-DUCTOR SET-UP 
 
The HSM-DUCTOR is shipped from the factory with the 
“HSMDCTR” application program loaded into the M4503 module.  
This is a standard program used to implement the HSM-DUCTOR 
pneumatic ductor algorithms.   
 
Once the HSM-DUCTOR is installed and the control system is 
powered up, perform the following.  
 
1) Modify the existing host PLC program such that the PLC output 

connected to B100.2 (Ductors Auto ON) is “ON” whenever cans 
are feeding into the decorator. 

 
2) Set the desired Maximum Cycle Duration. The Maximum Cycle 

Duration is set to 1/10th of a can resolution.  The range of this 
parameter is from 140 to 650 and defines the upper limit or the 
longest amount of time between ductor cycles.  Care should be 
taken not to set this parameter too low, as this would restrict the 
operators range of adjustment.  The “Cycle” duration is set 
individually for each ink station and is the rate at which ink is 
transferred from the fountain roll. 

 
3) Set the desired Maximum "On" Duration. The maximum “On” 

duration is set to 1/10th of a can resolution.  The range of this 
parameter is from 0 to 200 and defines the upper limit or the 
longest amount of time the ductor roll can be in contact with the 
fountain roll.  The “On” duration is set individually for each ink 
station and is the amount of time the ductor roll is in contact with 
the fountain roll. 

 
4) Set the Response Time Compensation. The response time 

compensation parameters is used to adjust the “On” duration 
based on the difference between the “ON” and “off” response 
time of the ductor solenoid.  As and example, if the “ON” 
response time were 40 msec. and the “off” response time was 15 
msec., then this parameter would need to be set to 25 msec. 

 
The “ON” response time is defined as the time ductor is activated 
to the time it comes in contact with the fountain roll.  The “off” 
response time is the time the ductor is deactivated to the time it 
lifts off of the fountain roll.  If the optional feedback sensors are 
to be used, this parameter should be set to zero. 

 
HSM-DUCTOR User’s Manual SYSTEMS Electronics Group 

 
- 13 - 



SECTION 2 
INSTALLATION 

5) Set the Color Gain parameter. This parameter allows the color 
density to be increased proportionately up or down as a function 
of machine speed.  The valid range of this parameter is 50% to 
150% per 2000 CPM.  When set to 100%, no increase or decrease, 
as a function of speed will occur.  When set to 50%, the color 
density will drop 50% from 0 to 2000CPM.  When set to 150% 
the color density will increase by 50% from 0 to 2000CPM.  This 
parameter is used to compensate for ink atomization (misting) as a 
function of speed (higher speed = proportionately higher ink 
misting). 

 
6) If the ductor feedback sensors are to be used, enable the particular 

stations that have feedback.  If the ductor feedback is not used, 
disable all stations. This parameter enables the individual 
feedback faults and should only be enabled when the optional 
feedback sensors are used.  Once enabled, the M4503 will verify 
that the ductor is cycling properly.  If a ductor is not detected as 
cycling properly, the “Ductor Feedback Fault” is energized, 
indicating a problem with the ductor cycling control.   

 
If a “Ductor Feedback Fault” does occur, the ductors should be 
manually activated to verify proper cycling operation, as well as, 
the sensor for proper feedback operation.  The feedback sensor 
should be set such that it is only “ON” when the ductor is in 
contact with the fountain roll. 
 

7) Enable “Set Passcode” and select “Color Control” to enter a new 
passcode.  If “Set-Up” is enabled the user will not be prompted to 
enter a new passcode.  Factory default is set to zero. 

 
8) Once set-up is complete, upload this data to disk using the “Set-

up” program software.  This allows the data to be downloaded to 
the module again if the module is replaced.  This data should be 
backed up on a periodic basis as labels are added or changed. 
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INSTALLATION 

________________________________________________________ 
2.8 M4503 MODULE INSTALLATION 
 
The following is provided as a reference.  These steps are performed 
by the factory, prior to shipping the HSM-DUCTOR.  These steps 
need only be performed in the event the M4503 module needs to be 
replaced.  Refer to the M4500 User’s Manual for general details on 
installing the M4503.  To install the M4503 module, perform the 
following: 
 
1) Mount the M4503 in the cut-out of the enclosure.  
 
2) Install the respective field wiring arms in the M4503 (I/O slots 0 

and 1, IN0/IN1 connector and resolver connector).  Make sure all 
the field wiring connectors are fully mated in the M4503. 
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INSTALLATION 

________________________________________________________ 
2.9 DOWNLOAD “HSMDUCTR” PROGRAM AND LABEL 
DATA TO M4503 
 
The following is provided only as a reference.  These steps are 
performed by the factory prior to shipping the HSM-DUCTOR.  
These steps need only be performed in the event the M4503 module 
needs to be replaced.  Once the M4503 is installed, perform the 
following to download the “HSMDCTR” application program to the 
M4503 as well as download the previously saved set-up: 
 
1) Power up the M4503 and the IBM PC or compatible used to 

interface with the HSM-DUCTOR. 
 
2) Connect an RS-232 cable from the computer COM port to the 

"PROG" port on the M4503. 
 
3) Invoke the set-up program 
 
4) Download the program to the M4503. See section 4.2.3 (Windows 

Setup Program Reference) or section 5.2 (DOS Setup Program 
Reference) for details on downloading the program to the M4503. 

 
5) Download the previously saved data to the M4503. See section 

4.2.4 (Windows Setup Program Reference) or section 5.3 (DOS 
Setup Program Reference) for details on downloading the 
program to the M4503. 

 
6) The M4503 is now ready to run, loaded with application program, 

ductor configuration, and label data that was previously saved for 
the respective decorator. Exit back to the DOS prompt by pressing 
<ESC>. 
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The Keypad/Display of the HSM-DUCTOR contains 24 keys 
consisting of 12 function keys, and a numeric keypad and a 2 line by 
40 character back-lit LCD display. The Keypad/Display can be used 
to view data, modify all set-up parameters or adjust the color control 
settings. 
 
 

 
 
Note: For virtually all the menus, the "NEXT" and "PREV" keys can 
be used to advance to the next item of the menu or return to the 
previous item on the menu. 
 
 
________________________________________________________ 
3.1 OVERVIEW OF KEYPAD AND DISPLAY 
 
<NEXT>: Pressing this key moves to the next adjustment field or 
displays the next menu or display.  Holding this key depressed for one 
second will move to the next field or display continuously.  If all 
displays have been shown the system will exit to the main default 
display. 
 
<PREV>: (Previous): Pressing this key moves to the previous 
adjustment field or displays the previous menu or display.  Holding 
this key depressed for one second will move to the previous field or 
display continuously.  If display selection is returned to the top of the 
order this key will have no effect. 
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<INC>: (Increment): Pressing this key once increments the currently 
selected field value by one.  Holding this key depressed for one 
second will increment the currently selected field continuously.  This 
key is only active in the adjustment mode. 
 
<DEC>: (Decrement): Pressing this key once decrements the 
currently selected field value by one.  Holding this key depressed for 
one second will decrement the currently selected field continuously.  
This key is only active in the adjustment mode. 
 
<DISPLAY DATA>: (Cycle Counts): Pressing this key displays the 
total number of cycles for each ductor.  Pressing this key the first time 
displays the counts for ductors 1 and 2, press the <NEXT> to advance 
to the next display, <PREV> to retard to the previous display.  The 
display will automatically advance to the next display approximately 
every 7.5 seconds until all cycling counts have been displayed. 
 
<RESET COUNTS>: Pressing this key allows the total cycle counts 
for each ductor to be reset.  A prompt is displayed asking which 
ductor to reset.  Enter the corresponding number of the ductor to reset 
that individual ductor count.  Press <0> to reset all the ductor counts.   
Press <ESC> to reset none of the ductor counts and return to the 
main menu. 
 
<SET UP>: Pressing this key allows the user to set-up the ductor 
configuration parameters.  This key is only active when set-up has 
been enabled. 
 
<ALARM RESET>: Pressing this key resets any active ductor fault 
alarms (feedback detected failure).  This key is only active when the 
main default display or fault display is active 
 
<COLOR CONTROL>: Pressing this key allows the operator to 
select a new label number, adjust the “Cycle” and “On” durations, 
independently for each ink stations or program a new label from 
scratch.  This key is passcode protected when the “Set-Up” switch is 
not disabled. 
 
When the “Color Control” key is depressed, the label selection screen 
is displayed.  The operator may enter in a new label number or simply 
press the <NEXT> or <ENTER> keys to advance to the station 
adjustment menus. 
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A number of different screens are shown on the display of the HSM-
DUCTOR.  The primary screen displays the machine cpm.  Other 
screens displayed include the cycling counts data display, reset 
cycling counts display, passcode entry menu and the set-up menu. 
 
 
________________________________________________________ 
3.2 RECOMMENDED PROCEDURE FOR USING THE  
HSM-DUCTOR 
 
On the original mechanically cammed ductor, the keys on the 
fountain were used both to control the areas on the can that the ink 
was to be applied as well as the color quality (light/dark) of the color.  
Thus the keys were adjusted proportionally to where on the can the 
color was located as well as how much area the color covered and 
how dark the color was. 
 
With the pneumatic ductor, the color quality is now controlled by the 
frequency and duty cycle of the ductor (as set by the operator through 
the Keypad/Display).  The fountain keys are simply used to define the 
locations (top, bottom, middle, etc.) the color is located on the can.   
The keys should not be adjusted proportional as before, but should be 
either closed at areas where there will be no color on the can, or 
opened (a predefined number of turns) on areas where the color is 
located on the can. 
 
This allows label changes to occur quicker by simply setting the keys 
open or closed at the locations required on the can, and selecting the 
label number for the respective label on the Keypad/Display (thus 
setting the color quality to the same level as previously set for that 
label). 
 
The M4503 is capable of saving the settings for up to 100 labels.  As 
different labels are run, the labels programmed are added to the 
internal data base.  When a programmed label is run again, simply 
recall the label number and the ductors will oscillate at the same 
frequency and duty cycle the last time the label was run.  The only 
additional set-up required at label change over is to set the keys open 
and closed at the required areas on the can. 
 
The following sections describe the recommended procedure for 
setting up a label and the recommended procedure for a label change 
over using a label, which has previously been programmed into the 
color control. 
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________________________________________________________
3.3 SET-UP PNEUMATIC DUCTOR PARAMETERS 
 
This menu is activated when the "Set-up” key is pressed.  The 
following set-up parameters may then be adjusted or viewed: 
 
Note:  For virtually all the menus, the <NEXT> and <PREV> keys 
can be used to advance to the next or previous parameter respectively.  
To change the currently displayed parameter, simply enter the new 
value on the numeric keypad and press <ENTER>.  The value will be 
entered and the next parameter will automatically be displayed.  
When the last parameter in a section is entered, the primary set-up 
menu is again displayed. Pressing <ESC> at anytime will exit back to 
the main display menu. 
 
The following parameters are used to define the ductor configuration:  
 
Maximum “Cycle” Duration:  The maximum “Cycle” duration is 
set to 1/10th of a can resolution.  The range of this parameter is from 
140 to 650 and defines the upper limit or the longest amount of time 
between ductor cycles.  Care should be taken not to set this parameter 
too low, as this would restrict the operators range of adjustment.  The 
“Cycle” duration is set individually for each ink station and is the rate 
at which ink is transferred from the fountain roll. 
 
Maximum “On” Duration:  The maximum “On” duration is set to 
1/10th of a can resolution.  The range of this parameter is from 0 to 
200 and defines the upper limit or the longest amount of time the 
ductor roll can be in contact with the fountain roll.  The “On” 
duration is set individually for each ink station and is the amount of 
time the ductor roll is in contact with the fountain roll. 
 
Response Time Compensation:  The response time 
compensation parameters is used to adjust the “On” duration based on 
the difference between the “ON” and “off” response time of the 
ductor solenoid.  As and example, if the “ON” response time were 40 
msec. and the “off” response time was 15 msec., then this parameter 
would need to be set to 25 msec.   
 
The “ON” response time is defined as the time ductor is activated to 
the time it comes in contact with the fountain roll.  The “off” response 
time is the time the ductor is deactivated to the time it lifts off of the 
fountain roll.  If the optional feedback sensors are to be used, this 
parameter should be set to zero. 
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Color Gain:  This parameter allows the color density to be increased 
proportionately up or down as a function of machine speed.  The valid 
range of this parameter is 50% to 150% per 2000 CPM.  When set to 
100%, no increase or decrease, as a function of speed will occur.  
When set to 50%, the color density will drop 50% from 0 to 
2000CPM.  When set to 150% the color density will increase by 50% 
from 0 to 2000CPM.  This parameter is used to compensate for ink 
atomization (misting) as a function of speed (higher speed = 
proportionately higher ink misting). 
 
Feedback Enable (stations 1 – 8):  This parameter enables the 
individual feedback faults and should only be enabled when the 
optional feedback sensors are used.  Once enabled, the M4503 will 
verify that the ductor is cycling properly.  If a ductor is not detected 
as cycling properly, the “Ductor Feedback Fault” is energized, 
indicating a problem with the ductor cycling control.   
 
If a “Ductor Feedback Fault” does occur, the ductors should be 
manually activated to verify proper cycling operation, as well as, the 
sensor for proper feedback operation.  The feedback sensor should be 
set such that it is only “ON” when the ductor is in contact with the 
fountain roll. 
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________________________________________________________ 
3.4 SELECTING THE LABEL NUMBER 
 
To select a label, perform the following: 
 
1)  Press the <COLOR CONTROL> key to enter the adjustment 

mode. 
 
2) If the prompt "ENTER PASSCODE:" is displayed, enter the 

corresponding 1 to 5 digit passcode on the numeric keypad and 
press <ENTER>.  If the prompt "ENTER PASSCODE: 
INCORRECT PASSCODE" is displayed, enter the correct 
passcode and press <ENTER>. 

 
3) The "LABEL" field is displayed.  Enter a new label (0-99) on the 

numeric keypad and press <ENTER> or press the <NEXT> key 
to use the existing label. 

 
 Note:  The decorator must be stopped in order to change the label 

number. 
 
4) If no further changes are to be made to the ink stations settings, 

press <ESC> to exit. 
 
 
________________________________________________________ 
3.5 LIGHT / DARK COLOR ADJUSTMENT OF INK STATION 
 
The “On” duration and “Cycle” duration for each ink station can be 
set individually for each label number.  The “On” duration can be 
viewed as a “Course” adjustment and the “Cycle” duration can be 
viewed as a “Fine” adjustment.  Observe how changing either the 
“On” duration or “Cycle” duration, changes the relative “Color 
Density”. 
 
Note:  If an ink station is not used, simply set its “On” duration to 
zero to disable the cycling operation. 
 
Use the “Color Density” display as an indication of the amount of ink 
being transferred by the ductor.  Different settings of the “On” and 
“Cycle” durations will achieve the same “Color Density”. 
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Note:  To reduce “Light” and “Dark” variations in print between 
cycle times, adjust both the “On” duration and “Cycle” duration down 
to achieve the same “Color Density”. 
 
For a new label or existing label that needs color adjustment, perform 
the following: 
 
1) Press the <COLOR CONTROL> key to enter the adjustment 

mode if not already in adjustment mode. 
 
2) To select the desired ink station for adjustment, press the 

<NEXT> or <PREV> keys until the desired ink station is 
displayed. 

 
3) To lighten the color, start by decreasing the “On” duration or 

increasing the “Cycle” duration.  Watch the “Color Density” to 
see how your adjustments change this value.  Remember, think of 
the “On” duration as a “Course” adjustment and the “Cycle” 
duration as a “Fine” adjustment. 

 
4) To darken the color, start by increasing the “On” duration or 

decreasing “Cycle” duration.  Watch the “Color Density” to see 
how your adjustments change this value.  Once again, think of the 
“On” duration as a “Course” adjustment and the “Cycle” duration 
as a “Fine” adjustment. 
 

5) Check the color quality and continue to increase or decrease the 
“Color Density” until the desired color quality is achieved. 

 
6) Perform steps (2) through (4) above for all ink stations used as 

necessary. 
 
7) Once the label quality is satisfactory, press the <ESC> key to exit 

the adjustment mode and save the changes for the selected label. 
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________________________________________________________ 
3.6 CHANGE OVER USING AN EXISTING LABEL IN THE  
HSM-DUCTOR 
 
When a label is to be run again, perform following to set-up the label 
at change over. 
 
1) Select the respective label number on the Keypad/Display. 
 
2) Set the keys open (predefined number of turns, a number which is 

used for all ink stations on all labels) on the areas of the can that 
will have ink and closed on areas that will not have ink. 

 
3) Run the machine and verify that ink is being distributed on the can 

correctly.  The ink will be metered at the same rate as previously 
set the last time the label was run.  Thus only minor adjustments 
to the keys may be necessary to assure that ink is not distributed 
to areas where no color is applied (resulting in slinging due to ink 
build up). 

 
 
________________________________________________________ 
3.7 VIEWING THE TOTAL NUMBER OF CYCLES FOR EACH 
DUCTOR 
 
The total number of cycles for each ductor is accumulated in the 
M4503.  This is used for life expectancy and predictive maintenance 
purposes to determine when air cylinders or solenoids should be 
replaced.  To view the number of cycles for each ductor, perform the 
following: 
 
1) Press the <DISPLAY DATA> key.  The total number of cycles 

for ductors 1 and 2 will be displayed. 
 
2) To view the counts for ductors 3 and 4, press <NEXT> key.  The 

counts for ductors 3 and 4 will be displayed. 
 
3) Continue pressing the <NEXT> key to view the counts for the 

remaining ductors. 
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________________________________________________________ 
3.8 RESETTING THE TOTAL NUMBER OF CYCLES FOR 
EACH DUCTOR 
 
To reset the total number of cycles for each ductor, perform the 
following.  Note this procedure should only be performed when 
replacing a component (air cylinder, solenoid, etc.) for a particular 
ductor. 
 
1) Press the <RESET COUNTS> key.  The "Reset Ductor Cycle 

Counts" screen will be displayed. 
 
2) To reset an individual ductor count, press the corresponding 

number of that ductor (1 to 8) and press <ENTER>.  The cycle 
count for that ductor will be reset. 

 
3) To reset the counts for all the ductors, press <0> and then 

<ENTER>. 
 
4) To exit out of the screen without resetting any of the ductor 

counts, press <ESC>. 
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The Windows based set-up program is menu driven, allowing the user 
to easily view data, alter set-up variables or set color control 
parameters using a PC running the Windows 
(95/98/ME/2000/XP/NT) operating system. The set-up variables are 
used to configure and tune the M4503 to match the configuration and 
performance of the specific printer (see section 2.7 - HSM-Ductor 
Set-up). 
 
Note:  The set-up program is an on-line communications program 
used to interface with the M4503 module.  The data displayed and set 
in the windows is communicated directly to the module, while in the 
“Online” edit mode. Therefore, prior to going online with the 
processor, make sure an RS-232 cable is connected from the COM 
port on the computer to the "PROG" port on the M4503.  The 
variables displayed while in the “Online” edit mode are read directly 
from the processor.  Data is saved to a “Set-up Data” file (*.sdt) 
whenever changes are made to a parameter or if the data is uploaded 
from the processor. 
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________________________________________________________ 
4.1 GENERAL DESCRIPTION 
 
Title Bar:  At the top of the window is the “Title Bar”.  The title bar 
is used to display the name of the working “Set-up Data” file, as well 
as, the name of the active “Window”.  The title bar is dark if the 
window is active and grayed if another window is active.  The color 
depends on the settings of the Display Properties of the Control Panel. 
 
Status Bar:  At the bottom of the window is the “Status Bar”.  The 
status bar is used to display system messages, online or offline mode, 
as well as, the current time and date as set by the operating system.  
The system messages panel displays general information about 
operation of the system.  The Online/Offline mode panel displays the 
status of the current set-up program mode of operation.  The mode of 
operation can be changed by simply double clicking the online/offline 
mode panel. 
 
Hot Keys:  Hot keys are activated by holding down the “ALT” key 
and simultaneously pressing the underlined letter of the desired 
function.  Almost every function can be activated by either pressing a 
series of hot keys or using the “TAB” key to move between fields. 
 
Online/Offline Modes:  The set-up program allows the user to 
make changes while “Online” with the processor.  The “Offline” 
mode is used to preset parameters prior to download.  All functions 
are available to the user while “Online”, however, specific “Online” 
functions are disabled in the “Offline” edit mode. 
 
Note:  Offline changes can only be made by enabling “Offline 
Editing”, accessed under the “Edit” menu. 
 
Getting Help:  The entire user’s manual is contained within the help 
file.  Pressing Ctrl+H will display the help file window.  Pressing the 
F1 key will display the contents file.  Hot spots allow jumps to other 
topics to display additional information as desired.  Selecting About 
RTFCD7 from the Help menu will display a dialog box listing 
information about the current revision of the setup program and how 
to obtain technical support. 
 

 
HSM-DUCTOR User’s Manual SYSTEMS Electronics Group 

 
- 28 - 



SECTION 4 
HSMDUCTOR WINDOWS BASED 
SETUP PROGRAM REFERENCE 

________________________________________________________ 
4.2 THE FILE MENU 
 
The “File” menu allows the user to perform the following functions: 
 
• Create a “New” set-up “Data File”. 
• Open an existing “Data File”. 
• Save any changes made to the current “Data File” to disk. 
• Upload (save) Data from the Processor. 
• Download a SYSdev (.sdv) program to the processor 
• Download (restore) Data from the current set-up “Data File” to 

the processor 
• Print a Report of the current set-up parameters. 
• Exit the set-up program 
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________________________________________________________ 
4.2.1 THE SET-UP DATA FILE 
 
The set-up “Data File” (.sdt) is a binary access file, designed for fast 
file I/O operation.  When the set-up program is first invoked, the 
default set-up parameters are loaded into memory.  If changes are 
made to any of the set-up parameters (either online or offline), as well 
as shift data, the user will be flagged to “Save Changes” upon exit of 
the program. 
 
Note:  Any windows based “Set-up” program can open a set-up 
“Data File”, however, the data tables will not be properly aligned.  
The user will be alerted to the problem if a set-up data file has been 
created by either a different set-up program or a different revision of 
the software. 
 
The set-up “Data File” is similar to that of a word processing file.  
When the program is first started, the default parameters are loaded 
and the user is able to make any changes as desired.  The set-up 
program is unaware of the settings and parameters that exist within 
the M4503.  Therefore, to normalize the set-up program with the 
processor, the user should define or open an existing file, then upload 
“All” variables from the processor.  This allows the user to either 
create a backup of the data or maintain an existing file.  The user can 
even open a data file for another printer, save the file to a new name, 
make the necessary changes and simply download the new parameters 
to another processor. 
 
The following functions can be accessed any time, from any set-up or 
display windows. 
 
New:  To create a “New” data file, select “New” from the “File” 
menu or press “Ctrl + N”.  This creates a completely new file, loaded 
with the default variables and the word “[unnamed]” is displayed in 
the title bar.  If any changes were made to the existing file, the user is 
prompted to save changes to the existing file. 
 
Open:  To “Open” and existing data file, select “Open” from the 
“File” menu or press “Ctrl + O”.  This displays a dialog box allowing 
the user to select an existing data file to open. The name of the file 
will be displayed in the title bar.  If any changes were made to the 
existing file, the user will be prompted to save any changes before 
terminating the program. 
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Save:  To “Save” data file to disk, select “Save” from the “File” 
menu or press “Ctrl + S”.  This displays a dialog box allowing the 
user to select a folder and enter a name for the file.  The user will be 
notified if the file already exists and the extension “.sdt” will 
automatically be added to the file name.  If this is a “New” file, the 
user will be prompted to enter a file name. 
 
Save As:  To save the data file to a new name, select “Save As” 
from the “File” menu..  This displays a dialog box allowing the user 
to select a folder and enter in a new name for the file.  The user will 
be notified if the file exists and the extension “.sdt” will automatically 
be added to the file name. 
 
Export Shift Data…:  This function allows the user to export the 
shift data to a “Tab Delimited” text file.  This allows the user to easily 
use the shift data to produce production reports. 
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________________________________________________________ 
4.2.2 UPLOAD (SAVE) DATA 
 
The “Set-up” program allows the user to upload set-up parameters, 
color control settings and shift data from the M4503 into a set-up 
“Data File”.  This function is accessed from the “File” menu and the 
user is given the choice of the following options: 
 

 
 
Set-up Data:  This option uploads the ductor cycling parameters 
data from the M4503.   
 
Shift Data:  This option uploads the “Shift Data” from the M4503.  
This is the individual cycling counts for each ductor. 
 
Label Data:  This option uploads the “Label Data” from the M4503.  
This is the ON duration and CYCLE duration settings for each label.  
The user will be prompted to select a range of labels to upload or 
select “All” (default). This allows the user to upload the label 
information from one processor and download it to another, without 
altering any of the other set-up parameters or shift data registers. 
 
All:  This option allows the user to completely upload “All” of the 
set-up parameters, shift data and label data from the M4503. 
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________________________________________________________ 
4.2.3 DOWNLOAD PROGRAM 
 
The “Set-up” program allows the user to “Download” any SYSdev 
program file to the M4503. 
 

 
 
Note:  To “Download” a SYSdev program to the processor, the 
program must be “Online”.  If “Online” mode cannot be achieved, 
program download will not be executed.  If the program is currently 
“Offline”, the user will be prompted to first go “Online”. 
 
Once selected, and the set-up program “Online” with the processor, a 
dialog box will be displayed, allowing the user to select the SYSdev 
file to download. 
 
Note:  Only the files with the “.sdv” file extension will be displayed.  
It is important to keep in mind that only a valid M4503 PLC SYSdev 
file can be downloaded through the set-up program.  Care should be 
taken when selecting a program to download. 
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Once selected, a message box is displayed informing the user of the 
current program, revision and checksum of the program loaded in the 
processor, as well as, that of the selected program.  The user must 
confirm their selection by clicking the “Yes” command button.  After 
the user confirms their choice, program download is initiated and the 
current program download address is displayed.  When program 
download is complete, the user is prompted to acknowledge.  Control 
is passed back to the main program and the set-up program remains in 
an “Online” edit mode. 
 
 
________________________________________________________ 
4.2.4 DOWNLOAD (RESTORE) DATA 
 
The set-up program allows the user to download  “Set-up” data, shift 
data and Label data to the M4503 from the set-up “Data File”.  This 
function is accessed from the “File” menu and the user is given the 
choice of the following options: 
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Set-up Data:  This option downloads the ductor cycling parameters 
data from the M4503.   
 
Shift Data:  This option downloads the “Shift Data” from the 
M4503.  This is the individual cycling counts for each ductor. 
 
Label Data:  This option downloads the “Label Data” from the 
M4503.  This is the ON duration and CYCLE duration settings for 
each label.  The user will be prompted to select a range of labels to 
download or select “All” (default). This allows the user to upload the 
label information from one processor and download it to another, 
without altering any of the other set-up parameters or shift data 
registers. 
 
All:  This option allows the user to completely upload “All” of the 
set-up parameters, shift data and label data from the M4503. 
 
Note:  Only the values contained within the current data file are used.  
If the validity of the current data file is questionable, review the data 
in an “Offline” mode prior to download. 
 
 
________________________________________________________ 
4.2.5 PRINT REPORT 
 
The “Set-up” program allows the user to generate a “Report” printout 
of all the set-up parameters, label data and shift data.  This function is 
accessed from the “File” menu. 
 
Prior to selecting “Print Report…”, the user should select “Report 
Setup” to set the following report printout options. 
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At the top of each page, the report displays the name of the set-up file 
being printed.  At the bottom of each page is the date and time the 
document was printed, as well as, the page number. 
 
To printout a report of the settings contained in the set-up “Data File”, 
perform the following: 
 
1) From the “File” menu, select “Print Report” or press “Ctrl + P”.  

This displays the “Print Setup” dialog box, allowing the user to 
select a printer, as well as, the paper size and orientation.  Once 
the user selects “OK”, the report is generated and sent to the 
specified printer device.  This function makes use of the windows 
print manager, which allows the user to continue with their work 
while the document is being printed. 

 
 
________________________________________________________ 
4.3 THE EDIT MENU 
 
The “Edit” menu allows the user to perform the following functions: 
 
• Enable/Disable Offline Editing 
• Set-up the Comm Port 
• Edit the Color Control Passcode 
 

 

 
HSM-DUCTOR User’s Manual SYSTEMS Electronics Group 

 
- 36 - 



SECTION 4 
HSMDUCTOR WINDOWS BASED 
SETUP PROGRAM REFERENCE 

________________________________________________________ 
4.3.1 ENABLE OFFLINE EDITING 
 
This function allows the user to perform “Offline” editing on the 
currently loaded set-up data file.  This allows the user the ability to 
make any necessary changes to the set-up parameters while not online 
with the processor.   
 
If offline editing is not enabled, the user is only able to view the set-
up parameters and shift data.  When the program is first invoked, the 
default setting is offline editing disabled.  The user will need to 
specifically select “Enable Offline Editing” from the edit menu (or 
press function key F2) to enable/disable this feature. 
 
 
________________________________________________________ 
4.3.2 SETUP COMM PORT 
 
This function allows the user to specify the serial communications 
port and baud rate to talk to the M4503.  The programming port of the 
M4503 is set to 9600 baud.   
 
Once selected, a dialog box requesting the user to select a “Comm 
Port” and “Baud Rate” will be displayed. 
 

 
 
The default setting is COM1 at 9600 baud.  The option to select the 
19200 baud rate is to allow the user to communicate with the 
processor via the S4516 serial communications board. 
 
The user will only need to specify the communications port and leave 
the baud rate at 9600.  If communication problems occur, make sure 
there is a secure connection from the PC to the PLC.  Then check the 
Comm port.  In most cases, the user will only need to select a new 
Comm port.  If communication problems persist, there may be 
another program causing a conflict with the port.  Check the port 
configuration from the “Settings” folder. 
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________________________________________________________ 
4.3.3 EDIT COLOR CONTROL PASSCODE 
 
The edit “Color Control Passcode” is an “Online” function only.  This 
allows the user the ability to directly change the value of the “Color 
Control Passcode”. 
 
Once selected, an input box is displayed, allowing the user to view 
the current “Passcode” setting and to change the value if necessary.   
 

 
 
If the passcode is set to zero, passcode entry is disabled.  The operator 
would then press the Color Control key on the Keypad/Display and 
then press the <ENTER> key to gain access to the color control 
settings without having to enter a zero.  
 
If the value of the “Color Control Passcode” is set somewhere 
between 1 and 65,000, “Passcode Entry” is enabled.  This requires the 
operator to enter in the “Correct” passcode to gain access to the color 
control parameters. 
 
Note:  Passcode entry is only in effect when the “Set-up Enable” 
selector switch is in the “Disable” position. 
 
If an invalid value is entered, the passcode value will not be reset and 
a message box notifying the user of the error is displayed.  
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________________________________________________________ 
4.4 THE VIEW MENU 
 
The “View” menu allows the user to perform the following functions: 
 
• View the “Target Board Interface” 
• View “Online” Data 
• View “Offline” Data 
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________________________________________________________ 
4.4.1 TARGET BOARD INTERFACE 
 
This function allows the user to view fault codes, S3000 network 
communication error codes and review the current “Ident” and 
“Revision” of the application program.  This is accessed by the 
“View” menu, by selecting “Target Board Interface”. 
 

 
 
Once invoked, the set-up program will prompt the user to select a 
program to compare with the one existing in the processor.  Whether 
a program is selected or the user cancels, the setup program will 
attempt to communicate with the M4503.  If unsuccessful, a warning 
message will be displayed, prompting the user to either “Retry” or 
“Cancel” the operation.  If the operation is canceled and 
communication with the processor cannot be established the system 
will be placed in an “Offline” mode, however the “Target Board 
Interface” window will be displayed. 
 

 
HSM-DUCTOR User’s Manual SYSTEMS Electronics Group 

 
- 40 - 



SECTION 4 
HSMDUCTOR WINDOWS BASED 
SETUP PROGRAM REFERENCE 

________________________________________________________ 
4.4.2 VIEW ONLINE DATA 
 
This function allows the user to place the set-up program in an 
“Online” mode with the processor.  This is accessed by the “View” 
menu, by selecting “Online Data” or by simply pressing the “F3” 
function key. 
 
Note:  The program can be toggled between “Offline” and “Online” 
by simply double clicking on the “Online” or “Offline” panel 
displayed in the status bar at the bottom of the window. 
 
Once invoked, the set-up program will attempt to open the Comm 
port and communicate with the M4503.  If the set-up program is 
unsuccessful, a warning message will be displayed prompting the user 
to either “Retry” or “Cancel” the operation.  If the operation is 
canceled and communication with the processor cannot be established 
the system will be placed in an “Offline” edit mode. 
 
Note:  Anytime while the set-up program is “Online” with the 
processor and communication is interrupted, a warning message will 
be displayed, prompting the user to either “Retry” or “Cancel” the 
operation. 
 
 
________________________________________________________ 
4.4.3 VIEW OFFLINE DATA 
 
This function allows the user to place the set-up program in an 
“Offline” mode.  This is accessed by the “View” menu, by selecting 
“Offline Data” or by simply pressing the “F4” function key.  This 
allows the user to perform “Offline” editing.  All values displayed in 
“Offline” edit mode reflect the actual values contained in the 
currently loaded set-up data file. 
 
Note:  The program can be toggled between “Online” and “Offline” 
by simply double clicking on the “Online” or “Offline” panel 
displayed in the status bar at the bottom of the window. 
 
Once invoked, the set-up program will close the Comm port and cease 
communication with the M4503. 
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________________________________________________________ 
4.5 THE WINDOW MENU 
 
The “Window” menu allows the user to select one of six different 
Display/Set-up windows to modify set-up parameters, view shift data 
or receive feedback about the current status of the control system. 
 

 
 
Once a window menu item is selected, a check mark is placed next to 
the selected item and the selected window is displayed with the name 
changed in the title bar of the main window. 
 
Note:  “Read” only variables are displayed in blue with a gray 
background.  Any variables that can be altered by the user are 
displayed in black with a white background.  In most cases, a 
parameter that can be changed by the user will have associated with it 
increment and decrement controls.  The user can either click on the 
desired parameter to adjust and enter in a new value, or use the 
increment or decrement controls to change the value by 1 unit. 
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________________________________________________________ 
4.5.1 THE MAIN DISPLAY WINDOW 
 
The “Main Display” window is used to display the general state of the 
control system.  This window is selected from the “Window”. 
 

 
 
The following is a list of the functions of the “Main Display” 
window. 
 
Messages:  The “Messages” display is continuously updated.  It 
displays alarm and status messages specific to the M4503, as well as, 
the current “Online” or “Offline” status of the set-up program.  By 
simply scrolling the display, the user is able to view all active alarm 
and status messages.  If no alarm or status messages are active, a 
default message is displayed. 
 
Machine CPM:  This display is only active while “Online” and 
displays the current speed of the machine in “Cans Per Minute”. 
 
Alarm Reset:  This function is only available “On-Line”. 
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________________________________________________________ 
4.5.2 THE SETUP PARAMETERS WINDOW 
 
The “Set-up Parameters” window is used to view and adjust any of 
the set-up parameters.  This window is selected from the “Window” 
menu. 
 

 
 
Cycling Parameters:  This is used to set the ductor solenoid 
control parameters in the M4503.  This section contains the following 
selections: 
 
1) Maximum Cycle Duration (0.1 cans):  The maximum cycle 

duration is the maximum cycle time (in 0.1 cans) for one cycle of 
the ductor.  This parameter limits the upper value that the operator 
can enter for the cycle duration.  If the operator attempts to enter a 
value higher then this limit, the value will default back to the 
original number.  The range of this parameter is 140 - 999. 

 
2) Maximum ON Duration (0.1 cans):  This parameter limits the 

upper value that the operator can enter for the “ON” duration.  
The cycle duration is the total cycle time (in 0.1 cans) that the 
ductor roll is in contact with the fountain roll.  If the operator 
attempts to enter a number higher than the maximum “ON” 
duration, the value will default back to the previous value.  The 
range of this parameter is 0 – 200. 
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3) Response Time Compensation (msec):  This parameter is 
the difference (in msec) between the “ON” and “off” response 
times of the ductor solenoid.  This is used to adjust the “ON” 
duration to compensate for the mechanical response time of the 
whole mechanism.  As an example, if the “ON” response time was 
40 msec. and the “off” response time was 15 msec.  Then the 
value entered for this parameter would be 25 msec. 

 
Note:  If the optional feedback sensors are used, set this 
parameter to 0.  The feedback sensors will automatically adjust 
the “ON” duration based on the response time of the solenoids. 

 
4) Color Gain:  This parameter allows the color density to be 

increased proportionately up or down as a function of machine 
speed.  The valid range of this parameter is 50% to 150% per 
2000 CPM.  When set to 100%, no increase or decrease, as a 
function of speed will occur.  When set to 50%, the color density 
will drop 50% from 0 to 2000CPM.  When set to 150% the color 
density will increase by 50% from 0 to 2000CPM.  This parameter 
is used to compensate for ink atomization (misting) as a function 
of speed (higher speed = proportionately higher ink misting). 

 
5) Enable/Disable Ductor Feedback Fault:  This selection is 

used to enable or disable the feedback fault detection.  When the 
optional feedback sensors are installed, the ductor feedback faults 
should be enabled.  The feedback sensor verifies the cycling of the 
ductor and resets the “ON” duration as the speed of the machine 
changes based on the response time of the solenoid.  
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________________________________________________________ 
4.5.3 THE SHIFT DATA WINDOW 
 
The “Shift Data” window is used to view the shift data collected by 
the M4503.  This window is selected from the “Window” menu. 
 

 
 
Cycle Counts: This displays the total number of cycles for each 
ductor.   
 
Reset Counts: Pressing this key allows the total cycle counts for 
each ductor to be reset.  The user can also choose to reset an 
individual ductor by setting or incrementing the “Ductor Number” 
and then pressing the Reset Counts command button. 
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________________________________________________________ 
4.5.4 THE COLOR CONTROL WINDOW 
 
The “Color Control” window is used to view and adjust any of the 
color control settings.  This window is selected from the “Window” 
menu. 
 

 
 
 
Color Control Parameters:  The label number, “On” duration and 
“Cycle” duration are used to adjust the color control settings in the 
M4503.   
 
The following is a description of each of these settings: 
 
1) Label Number:  The M4503 is capable of storing the settings 

for up to 100 labels (0-99).  Select desired label number to adjust 
the “On” and “Cycle” duration settings. 

 
 Note:  The user can only adjust the “Label Number” when the 

machine is at “Zero Speed” (main drive off and no motion 
detected). 
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2) On Duration:  The “On” duration can be individually set for 
each ink station, for each label.  The “On” duration is the amount 
of time (cans) the ductor roll is in contact with the fountain roll.  
Follow the procedure outlined in section 3.5 – Light/Dark Color 
Adjustment of Ink Station, to properly adjust the “On” duration. 

 
 Note:  The user cannot adjust the “On” duration to within 14 cans 

(140 tenths) of the “Cycle” duration.  To disable a ductor from 
cycling, set this variable to zero. 

 
3) Cycle Duration:  The “Cycle” duration can be individually set 

for each ink station, for each label.  The “Cycle” duration is the 
frequency at which the ductor is activated.  This is the duration 
(number of cans) between one complete cycle.  Follow the 
procedure outlined in section 3.5 – Light/Dark Color Adjustment 
of Ink Station, to properly adjust the “Cycle” duration. 

 
 Note:  The user cannot adjust the “Cycle” duration to within 14 

cans (140 tenths) of the “On” duration. 
 
4) Color Density:  The “Color Density” display is used as an 

indication of the amount of ink being transferred by the ductor.  
Different settings of the “On” and “Cycle” durations will achieve 
the same “Color Density”.  Follow the procedure outlined in 
section 3.2 – Recommended Procedure for using the color control. 
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Solenoid Response Time:  The “Solenoid Response” time is an 
indication of the reaction time of pneumatic ductor.  The response 
times are only valid when the optional feedback sensors are used.  
The response times for each ink station can be easily viewed by 
adjusting the station number.   
 
The following is a description of each of these settings: 
 
1) Station Number:  The ink station mask to view the response 

time of the ductor solenoid. 
 
2) Solenoid “On” Response Time (msec):  This displays the 

amount of time (msec) from first activation of the solenoid to 
contact with the fountain roll. 

 
3) Solenoid “Off” Response Time (msec):  This displays the  

amount of time (msec) from first deactivation of the ductor 
solenoid to lift-off from fountain roll. 

 
 
Ductor Status:  The ductor “Status” gives the user an indication of 
the status of the input signals used to control the pneumatic ductor, 
these are as follows: 
 
1) Operational Mode:  A three-position selector switch is used to 

set the operation mode of the ductors (auto/off/manual).  This 
display reflects the position of the selector switch. 

 
2) Ductors Auto On:  This displays the state of the ductors “Auto 

On” input to the M4503 
 
 
Ductors Manual Control:  This allows the user to toggle 
individual ductor solenoids when the ductors operational mode is 
“Manual” and the machine is at “Zero” speed (main drive off, 
machine not in motion).  The individual solenoids can be toggled 
“On” and “Off” by clicking on the individual stations.  The user may 
also toggle “All” the ink stations “On” by clicking the “Ductors ON 
All” command or toggle all “Off” by clicking the “Ductors OFF All” 
command button. 
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________________________________________________________ 
4.5.5 THE I/O STATES WINDOW 
 
The “I/O States” window is provided to display states of the inputs 
and outputs.  The control boards, as well as states of the M4503 are 
shown.  This includes the interrupt inputs (IN0 and IN1), the analog 
I/O and the resolver.  These values are displayed as read by the 
M4503 processor. 
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The DOS based "HSMDCTR" set-up program is menu driven, 
allowing the user to easily view data, alter set-up variables and set 
color control parameters using a laptop or personal computer. The set-
up variables are used to configure and tune the HSMDCTR to match 
the configuration and performance of the specific printer (see section 
2.7 – HSM-Ductor Set-up). 
 
The main menu of the "HSMDCTR" set-up program incorporates the 
following menu selections: 
 

 
 
Note:  The set-up program is an on-line communications program 
used to interface with the M4503 module.  The data displayed in the 
menus and set in the menus is communicated directly to the module. 
Therefore, prior to selecting any of the selections, make sure an RS-
232 cable is connected from the COM port on the computer to the 
"PROG" port on the M4503. 
 
The following sections are a complete description of the set-up 
program selections and menus. 
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________________________________________________________ 
5.1 SET DUCTOR PARAMETERS 
 
This selection is used to set the ductor solenoid control parameters in 
the M4503.  
 
The "Set Ductor Parameters" menu contains the following selections: 
 

 
 
________________________________________________________ 
5.1.1 SET MAXIMUM CYCLE DURATION (0.1 CANS) 
 
The maximum cycle duration is the maximum cycle time (in 0.1 cans) 
for one cycle of the ductor.  This parameter limits the upper value that 
the operator can enter for the cycle duration.  If the operator attempts 
to enter a value higher then this limit, the value will default back to 
the original number.  The range of this parameter is 140 - 999. 
 
 
________________________________________________________ 
5.1.2 SET MAXIMUM ON DURATION (0.1 CANS) 
 
This parameter limits the upper value that the operator can enter for 
the “ON” duration.  The cycle duration is the total cycle time (in 0.1 
cans) that the ductor roll is in contact with the fountain roll.  If the 
operator attempts to enter a number higher than the maximum “ON” 
duration, the value will default back to the previous value.  The range 
of this parameter is 0 – 200. 
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________________________________________________________ 
5.1.3 SET SOLENOID RESPONSE TIME COMPENSATION 
(msec) 
 
This parameter is the difference (in msec) between the “ON” and 
“off” response times of the ductor solenoid.  This is used to adjust the 
“ON” duration to compensate for the mechanical response time of the 
whole mechanism.  As an example, if the “ON” response time was 40 
msec. and the “off” response time was 15 msec.  Then the value 
entered for this parameter would be 25 msec. 
 
Note:  If the optional feedback sensors are used, set this parameter to 
0.  The feedback sensors will automatically adjust the “ON” duration 
based on the response time of the solenoids. 
 
 
________________________________________________________ 
5.1.4 SET COLOR GAIN 
 
This parameter allows the color density to be increased 
proportionately up or down as a function of machine speed.  The valid 
range of this parameter is 50% to 150% per 2000 CPM.  When set to 
100%, no increase or decrease, as a function of speed will occur.  
When set to 50%, the color density will drop 50% from 0 to 
2000CPM.  When set to 150% the color density will increase by 50% 
from 0 to 2000CPM.  This parameter is used to compensate for ink 
atomization (misting) as a function of speed (higher speed = 
proportionately higher ink misting). 
 
 
________________________________________________________ 
5.1.5 ENABLE / DISABLE DUCTOR FEEDBACK FAULT 
 
This selection is used to enable or disable the feedback fault 
detection.  When the optional feedback sensors are installed, the 
ductor feedback faults should be enabled.  The feedback sensor 
verifies the cycling of the ductor and resets the “ON” duration as the 
speed of the machine changes based on the response time of the 
solenoid. 
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________________________________________________________ 
5.2 DOWNLOAD PROGRAM TO MODULE 
 
This selection is used to download the application program to the 
M4503 module.  This should only be performed when either replacing 
the module or when the program has been changed.  To download the 
program, perform the following: 
 
Note:  Program download should not be performed while the 
decorator is running.  All outputs on the M4503 are turned "off" and 
no program execution is performed.  The decorator should therefore 
be stopped before the download takes place. 
 
To download the program, perform the following: 
 
1) Connect the RS-232 cable from the COM port on the computer to 

the "PROG" port on the M4503. 
 
2) Select "2: Download Program to Module" from the Main Menu.  

The current program ident, revision, and checksum for both the 
program on disk and already loaded in the module will be 
displayed.  A prompt will be displayed asking to continue or 
abort.  To continue, press any key except the <ESC> key.  To 
abort, press the <ESC> key.  If a prompt stating that the file could 
not be opened is displayed, then the application program is not 
installed in the current directory. 

 
3) Once program download is initiated, program execution will 

cease, the current address being downloaded will be displayed, 
and the "RUN" LED on the module will flash continuously. 

 
4) Once the download is complete, the "RUN" LED on the module 

will illuminate solid and program execution in the M4503 will 
resume. Press any key to return back to the main menu. 

 
5) This selection can also be used to verify the program ident, 

revision, and checksum without downloading the program.  
Perform steps 1 through 3 above but instead of initiating the 
download in step 3, simply press the <ESC> key to abort the 
download once the ident, revision, and checksum have been 
displayed. 
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________________________________________________________ 
5.3 DOWNLOAD SET-UP DATA TO MODULE 
 
This selection is used to download the previously uploaded (saved) 
set-up variables to the M4503 module.  This should only be 
performed when replacing the module.   
 
Note:  The set-up data consists of the parameters listed in the “1: Set 
Ductor Parameters” menu.  
 
To download the set-up data, perform the following: 
 
1) Connect the RS-232 cable from the COM port on the computer to 

the "PROG" port on the M4503. 
 
2) Select "3: Download Set-up data to Module".  A prompt will be 

displayed asking to continue or abort.  To continue, press any key 
except the <ESC> key.  To abort, press the <ESC> key. 

 
3) Once data download is initiated, the current address being 

downloaded will be displayed.   
 

Note:  M4503 program execution is not ceased, therefore data 
download can be performed while the machine is running. 

 
4) Once set-up data download is complete, press any key to return to 

the main menu. 
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________________________________________________________ 
5.4 UPLOAD (SAVE) SET-UP DATA FROM MODULE 
 
This selection is used to save set-up variables from the M4503 to the 
hard drive (current directory selected).  This should be performed 
periodically to save the label data settings or whenever any of the set-
up variables are changed.   
 
Note:  When the set-up variables are changed, they are changed 
directly in the module, not on the file in the computer.  By uploading 
(saving) the set-up variables to disk, they can be downloaded to the 
module in the event the module must be replaced. 
 
The set-up data consists of the parameters listed in the “1: Set Ductor 
Parameters” menu.  To upload the set-up data, perform the following: 
 
1) Connect the RS-232 cable from the COM port on the computer to 

the "PROG" port on the M4503. 
 
2) Select "4: Upload (Save) Set-up data from Module".  A prompt 

will be displayed asking to continue or abort.  To continue, press 
any key except the <ESC> key.  To abort, press the <ESC> key. 

 
3) Once data upload is initiated, the current address being uploaded 

will be displayed.   
 

Note:  M4503 program execution is not ceased, therefore data 
upload can be performed while the machine is running. 

 
4) Once set-up data upload is complete, press any key to return to the 

main menu. 
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The following is a recommended spare parts list for the HSM-
DUCTOR.   These parts are available through Systems Engineering 
Associates, Inc. 
 
 Quantity Part Number Description 
 1 ea. HSM-DUCTOR Decorator Cyclic Ductor 

Control Module (M4503) 
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